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Safety Precautions 
 
Before performing design, construction, or maintenance thoroughly, read the “Safety Precautions” in the 
installation manual provided with the product. 

1. Introduction 
 
A Building Manangement System (BMS) can control Daikin units through the Modbus protocol by using the 
Modbus Interface DIII EKMBDXB7V1.  
 
Glossary: 
- BMS: Building Management System 
- DIII unit: Unit with DIII communication connected to the Modbus Interface DIII. 
- DIII device: A centralised device from Daikin with DIII communication (e.g. iTM, …) 
- Indoor unit: As the main target is to monitor and control VRV connected indoor units, the DIII units are 
referred to as indoor units. For some systems the connected DIII units are in reality outdoor units (e.g. Applied 
units) 
 

1.1 System layout 
 
Typical setup (e.g. VRV) 

 
 
DIII address (Group NO) needs to be set on an individual indoor unit or group by the connected userinterface. 
Functions of each Indoor unit in a range for each register: 
Example: 

Register address DIII address functions 

31001 – 31003 1-00 

31004 - 31006 1-01 

… … 

 

BMS 

Outdoor 

Outdoor 

Indoor Indoor Indoor 

1-00 1-01 1-02 DIII address 

   

Indoor Indoor Indoor 

1-03 1-04 1-05 DIII address 

   

 
Modbus Interface DIII 

RS485 Modbus protocol 
2 wire, max wire length 500m 

DIII indoor 
connection 

DIII outdoor 
connection 

One Modbus slave 
address  
(e.g. 1) 
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1.2 Limitations 
 
The number of control commands per indoor unit is limited to 7000 per year. 
If the BMS controls the units by using an automatic control program, please make sure it doesn’t exceed this 
limitation. 

1.3 Specifications 
 

Daikin equipment connection DIII net (F1F2) 
maximum 64 indoor units (groups) and maximum 10 outdoors (addr 1-00 till 4-15) 

BMS equipment protocol Modbus RS485 (2 wire, max 500m) 

Installation place Indoor installation 

Operation condition Temp range 0 till 60°C 

Dimensions 379 x 87 x 124 mm 

Mass (Weight) 2,1 kg 

Power supply 220 – 240 VAC 50/60 Hz 

 

Software The Modbus Interface DIII software can be updated with the Daikin Updater PC software  
Refer to chapter “4.2 Software update with Updater” for details. 

 

Installation manual Provided with the option 

Design guide Latest version available on:  
http://www.daikineurope.com/support-and-manuals/product-information 

 
  

http://www.daikineurope.com/support-and-manuals/product-information
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1.3.1 Dimensions and field wiring 
 
Refer to installation manual 
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1.3.2 Wiring diagram 
 

 
 

1.3.3 LED meaning 
 
During normal operation (application is running): 
H1P: DIII communication (sent) 
H2P: DIII communication (receive) 
H3P: RS485 communication (sent) 
H4P: RS485 communication (receive) 
H5P H6P H7P: no meaning 
HAP: blinking at 400ms = application is running 
 
During uploading of new software (firmware is running) 
H1P till H7P: Progress indication (0 till 100%) 
HAP: blinking at 200ms = firmware is running. 

1.3.4 Termination resistance (SS switches) 

 
By factory default the termination resistance is 0 Ohm (SS2=Off & SS3 =Off) 
 
SS2 On = 120 Ohm  
SS3 On = 100 Ohm  
(SS2 = On & SS3 = On, not allowed) 
 
Please slide the SS2 or SS3 to the ON position to set required termination resistance value of the RS485 line. 

 

 
 
Remark: SS1: not used. 
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1.3.5 Push buttons 
 
BS1 till BS5 have no meaning 
 

1.3.6 Dipswitch meaning 
 

Attention: Dipswitch on/off status is detected during power on of the PCB only. A power reset is needed after 

setting the switches. 

Dipswitch DS1 & DS2 setting: 
 

RS485 Modbus communication speed 

DS1 pin 2:Off 
DS1 pin 2:On 

9600 bps 
19200 bps 

Modbus communication parity / stop bit 

DS1 pin 3:Off 4:Off 
DS1 pin 3:Off 4: On 
DS1 pin 3:On 4:Off 
DS1 pin 3:On 4:On 

Even 1 stop bit 
Odd 1 stop bit 
None 2 stop bit 
None 1 stop bit 

Modbus address setting 

DS2 pin 1/2/3/4 When Modbus address is set (eg 1..15), then modbus RS485 communication is 
enabled. 

Off/Off/Off/Off No Modbus address is set, meaning no modbus RS485 communication 

Off/Off/Off/On 
Off/Off/On/Off 
… 
On/On/On/On 

Address 1 
Address 2 
 
Address 15 

 
Attention: 
During software upload with updater PC program via RS485 port a specific dipswitch setting is required. 
Refer to chapter “4.2.3 Method 2) Update with a USB/RS485 converter.” for details. 
 

 

Remark: DS1 – pin 1: not used. 
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1.4 Overview of compatible Daikin units ranges with DIII connection 
 
For compatibility with a specific model, please check the manual of the corresponding model. Updates of the 
software will be available on the Business Portal (maintenance by Service)). 
 
Product overview: 

• SKY (F1,F2) 

• VRV (F1,F2) 

• RA (via KRP928) 

• VAM / VKM 

• EKVDX 

• VRV Hydro Box 

• Air curtains 

• ERQ-Control box (connection to 3rd party AHU) 

• Heating 

• Applied 

 

1.5 Overview of compatibilty with other DIII centralised control equipment 
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DIII Modbus 
interface EKMBDXB7V1 OK NG NG OK NG NG OK OK NG 

 
 
(*1): The schedule timer should be used in combination with the central remote controller or unified ON/OFF 
controller 
    

• If using in combination with centralized control equipment, the relation between both 

central remote controllers is last command priority. 
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• if using in combination with centralized control equipment, the remote control mode is 

decided by the setting of the highest priority item in the priority rank. 

    
Priority ranking of Modbus Interface DIII: 
No priority ranking is implemented. Meaning, in case another D-BACS device is detected, the lock button & 
force OFF functions are not available. 
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2. Modbus communication 

2.1 Modbus Interface DIII settings 
Communication protocol Modbus RTU 

(according to “Modicon Modbus Protocol reference guide” PI-
MBUS-300 Rev J) 

Dipswitch setting  
 

Communication speed 9600 bps 
Or 19200 bps 

DS1 pin 2:Off 
DS1 pin 2:On 

Parity / stop bit Even 1 stop bit 
Odd 1 stop bit 
None 2 stop bit 
None 1 stop bit 

DS1 pin 3:Off 4:Off 
DS1 pin 3:Off 4: On 
DS1 pin 3:On 4:Off 
DS1 pin 3:On 4:On 

One dedicated modbus 
address setting 

1..15 DS2 pin 1/2/3/4 
Addr 1: Off/Off/Off/On 
Addr 2: Off/Off/On/Off 
… 
Addr 15: On/On/On/On 

Implemented function codes 0x03 Read Holding Registers (broadcast support) 
0x04 Read Input Registers (broadcast support) 
0x06 Preset Single Registers (No broadcast support) 
0x10 Preset Multiple Registers (No broadcast support) 
(remark: Holding Registers will not reflect the actual value) 
(other function codes are treated as illegal function and 
return an exception response) 

 

Data types Input Register: 
Length 16 bits, Address range: 30001 - 39999 
Holding Register 
Length 16 bits, Address range: 40001 – 49999 
(Data larger than 16 bits can be handled by assigning 
continuous addresses to registers.) 

 

Register addresses Same address meaning for each applicable model  
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2.2 Communication format 

2.2.1 Function format 
 
(1) Read Input Registers (0x04) 
[Function] 
Read values of input registers. The address and the content of input registers are described in 
3. Modbus registers 
 
[Query] 
The query message specifies the start address of the register and the number of registers. The register address 
starts at zero: register 30001 is addressed as 0. 
This function can read up to 32 registers in one query. 
Here is an example of a request to slave address 1 for reading 3 register values starting from register 31001. 
 
 

Query  Response 

Field Data Field Data 

Slave Address  0x01 Slave Address  0x01 

Function Code  0x04 Function Code 0x04 

Start Address(Upper)  0x03 Data Size(Bytes) 0x06 

Start Address(Lower)  0xE8 Data1(Upper)  0xXX 

Number of Registers(Upper)  0x00 Data1(Lower) 0xXX 

Number of Registers(Lower)  0x03 Data2(Upper) 0xXX 

Error Check CRC16(Lower)  0x30 Data2(Lower) 0xXX 

Error Check CRC16(Upper)  0x7B Data3(Upper) 0xXX 

  Data3(Lower) 0xXX 

  Error Check CRC16(Lower) 0xXX 

  Error Check CRC16(Upper) 0xXX 
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(2) Preset Single Register (0x06) 
[Function] 
Write a value to a holding register. In case of broadcast, the value is written to the same holding register of all 
slave units. The address and the content of the holding registers are described in 
3. Modbus registers 
 
[Query] 
The query message specifies the start address of the register and a value. The register address starts at zero: 
register 40001 is addressed as 0. Here is an example of a request to slave address 1 for writing the value ‘2’ to 
register 42002. 
 
 

Query  Response 

Field Data Field Data 

Slave Address  0x01 Slave Address  0x01 

Function Code  0x06 Function Code 0x06 

Address(Upper)  0x07 Address(Upper)  0x07 

Address(Lower)  0xD1 Address(Lower)  0xD1 

Value(Upper) 0x00 Value(Upper) 0x00 

Value (Lower) 0x02 Value (Lower) 0x02 

Error Check CRC16(Lower)  0x59 Error Check CRC16(Lower)  0x59 

Error Check CRC16(Upper)  0x46 Error Check CRC16(Upper)  0x46 

 
(3) Preset Multiple Registers (0x10) 
[Function] 
Write values to holding registers. In case of broadcast, the values are written to the same holding registers of 
all slave units. The address and the content of holding registers are described in 
3. Modbus registers 
 
[Query] 
The query message specifies the start address of the register, size of data and values. The register address 
starts at zero: register 40001 is addressed as 0. This function can write up to 30 registers in one query. Here is 
an example of a request to slave address 1 for writing 2 values to register 42001 and to register 42002. 
 

Query  Response 

Field Data Field Data 

Slave Address  0x01 Slave Address 0x01 

Function Code  0x10 Function Code 0x10 

Start Address(Upper)  0x07 Start Address(Upper) 0x07 

Start Address(Lower)  0xD0 Start Address(Lower) 0xD0 

Number of Registers(Upper)  0x00 Number of Registers(Upper) 0x00 

Number of Registers(Lower)  0x02 Number of Registers(Lower) 0x02 

Data Size(bytes)  0x04 Error Check CRC16(Lower) 0x41 

Value1(Upper)  0x00 Error Check CRC16(Upper) 0x45 

Value1(Lower)  0x10   

Value2(Upper)  0x00   

Value2(Lower)  0x01   

Error Check CRC16(Lower)  0x18   

Error Check CRC16(Upper) 0xC6   
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(4) Exception response 
 
In case the query message is faulty, the Modbus Interface DIII will reply an exception response. In normal 
conditions the function code of the response message is the same as the query message. But in case of an 
error, 0x80 is added to the function code of the response message. 
The exception response includes the exception code, indicating the cause of the error. 
 

Exception code Name Cause 

0x01 Illegal function This function code is not supported. 

0x02 Illegal data address Access was attempted to an unassigned register 
address. 

0x03 Illegal data This query includes unauthorized data. 

 
 
[Example of exception response] 
In the case of setting an illegal mode to the holding register address 42002. 
 

Query  Response 

Field Data Field Data 

Slave Address  0x01 Slave Address  0x01 

Function Code  0x06 Function Code  0x86 

Start Address(Upper)  0x07 Exception Code  0x03 

Start Address(Lower)  0xD1 Error Check(Lower)  0x02 

Number of Registers(Upper)  0x01 Error Check(Upper)  0x61 

Number of Registers(Lower)  0x0F   

Error Check(Lower) 0x99   

Error Check(Upper) 0x13   
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2.2.2 Character format 
 
Each byte of a message is sent as character data as follows. 
A character consists of start bit (0), 8 bits data, parity bit and stop bit (1). One character size is always 11 bits 
and stop bit 1 or 2 is selected by parity bit. 
 
[Non Parity] 
 

0 (LSB) 1 2 3 4 5 6 7 8 9 10 (MSB) 

Start bit Data Stop bit 1 Stop bit 2 

 
[Parity] 
 

0 (LSB) 1 2 3 4 5 6 7 8 9 10 (MSB) 

Start bit Data Parity bit 
(Odd or 
Even) 

Stop bit 2 

 

2.2.3 Silent internal time 
 
Every frame needs to have silent interval time (T1-T2-T3-T4) before and after. The silent interval time is 
depending on communication speed. 

Baud Rate(bps)  9600 19200 

Silent Interval Time(ms) 
(T1-T2-T3-T4) 

5 2,5 

 

2.2.5 Response time 
 
This Modbus Interface DIII responds a message after response time(t1) when this Modbus Interface DIII 
receives a query message. The response time(t1) of this adaptor is “Silent Interval Time(T1-T2-T3-T4) + 20ms”. 
Modbus master needs to wait to send next query message for time interval(t2) when the modbus master 
receives a response from the Modbus Interface DIII. The time interval(t2) should be more than “Silent Interval 
Time(T1-T2-T3-T4) + 20ms”. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Modbus master 

Modbus Interface DIII 

Query message 

Response 

Query message 

t1 t2 

t1 = (T1-T2-T3-T4) + 20 (ms) t2 >= (T1-T2-T3-T4) + 20 (ms) 
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2.3 Communication procedure 

2.3.1 System initialisation 
 
At startup:  
- All input registers have values 0.  
After the discovery of the DIII connected units, the “DIII unit connected status bit” (see Input registers 30002 
till 30006) will be updated to “1: connected“ and the input registers of the connected DIII units (30001 and 
higher) will have the correct values. 
 
- All the holding registers have initial values 0.  
After the discovery of the DIII connected units, the “DIII unit connected status bit” (see input registers 30002 
till 30006) will be updated to “1: connected” and the holding registers of the connected DIII units (42001 and 
higher) will be updated to the actual values once. 
 
Attention: The holding values receive the actual values at the detection time only. This means this will only 
happen once. (Remark: also not during rediscovery) 
 
 
 
  

Retrieve status 

Return: Busy 

Check Modbus Interface DIII status (30001) 

BMS Modbus Interface DIII DIII unit 

Power on 

Power on 

Modbus Interface DIII status 
(30001 bit 0): Busy 

Return: Ready 

Check Modbus Interface DIII status (30001) 

Modbus Interface DIII status 
(30001 bit 0): Ready 

Return: Ready 

Check DIII unit connected status (30002-5) 

Check status when 
Modbus Interface 
DIII is ready 

BMS gets all DIII 
units connected 
addresses 

Return values 

Check DIII unit capabilities BMS gets all DIII 
units capabilities 

BMS gets all DIII 
units current 
status by reading 
the input registers 
and read all 
values of the 
holding registers  

Return values 

Check DIII unit status (input registers) & read 
holding registers 



4P642495-1A– 2022.02  Page 16 of 52 
 

2.3.2 Monitor and operate units from the BMS 
 
Input registers of each DIII unit: 30001 and higher 

The input registers will contain the status of the connected DIII units. 

In case the DIII communication is interrupted (see Input registers 30006 till 30009): then the last 
communicated values will remain, until the DIII communication is restored.  
 
Status changes are communicated continuously to the input registers, meaning the input registers will contain 
the actual values. 
 

Holding registers of each DIII unit: 42001 and higher 

- Writing instructions to change a unit status (Preset Single or Multiple Registers) 
When a value is written to a holding register, it will be communicated to the DIII units. 
 
Attention: Modbus Interface DIII sends the command to a unit when the value of a Holding Register is 
changed. Especially in case that indoor units are operated from the user interface, the BMS should always get 
the status of indoor units and copy the received status to the Holding Registers. 
 
Note: at start-up of the system (See 2.3.1 System initialisation) and the initial discovery of the DIII connected 
units, the Modbus Interface DIII put the actual status in the holding registers. (Remark: not during rediscovery.) 
 
 
 
 
 
  

Change on/off 

Return: status 

Check communication status (30006-9) 

BMS Modbus Interface DIII DIII unit 

BMS checks 
communication 
status 

Copy:  
BMS gets all DIII 
units current 
status by reading 
the input registers 
and copies to the 
related bits (pre-
set) to the holding 
registers  

Return values 

Get DIII unit status (input registers) 

Preset DIII unit status to the holding register 

Command: 
BMS changes a 
value in the 
holding registers  

Preset On/Off bit to the holding register 



4P642495-1A– 2022.02  Page 17 of 52 
 

Step by step explanation of the required copy of the BMS. 
 
Below is an example for On/Off operation. 
 
Note: The interval setting to the same register is over 0.5s. 
 
[Legend] 
 

 
 
[On/Off operation sequence example] 
1. The BMS receives the Off status of units (1) and copies the input status to Holding registers (2). 

 
 
2. The BMS sends an On command to the unit. 

 
3. The BMS gets the status of the input register (1) and copies the received status to the holding registers (2). 
 

 

  

Modbus 

User 
interface 

Status 
Setting status 

BMS 

Received status 

Holding register 
present value 

Modbus Interface DIII 

Input Register 

Holding register The 
last value 

Status 

Unit 

  

DIII 

(2) Off 

(1) Off 

User 
interface 

Off 
Off 

BMS 

Off 

Off 

Modbus Interface DIII 

Off 
Off 

Unit 

  

Off 

On 

User 
interface 

On 
On 

BMS 

- 

On 

Modbus Interface DIII 

On 
On 

Unit 

  

Off 
On 

The value of the holding register is changed.  So the Modbus Interface DIII 
sends the command to the units. 

On 

(2) On 

(1) On 

User 
interface 

On 
On 

BMS 

On 

On 

Modbus Interface DIII 

On 
On 

Unit 

  

On 
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4. The unit is switched Off by the user interface. 

 

5. The BMS gets the status of the input register (1) and copies the received status to the holding registers (2). 

 

6. The BMS sends an On command to the unit. 
 

 
7. The BMS gets the status of the input register (1) and copies the received status to the holding registers (2). 

 

 

  

Off 

User 
interface 

On 
- 

BMS 

- 

On 

Modbus Interface DIII 

Off 
Off 

Unit 

  

On 

Off 

(3) Off (2) Off 

(1) Off 

User 
interface 

Off 
Off 

BMS 

Off 

Off 

Modbus Interface DIII 

Off 
Off 

Unit 

  

On  

The value of the holding register is changed.  So the Modbus Interface DIII 
sends the command to the units (3). 

On 

User 
interface 

On 
On 

BMS 

- 

On 

Modbus Interface DIII 

On 
On 

Unit 

  

Off 
On 

The value of the holding register is changed.  So the Modbus Interface DIII 
sends the command to the units. 

On 

(2) On 

(1) On 

User 
interface 

On 
On 

BMS 

On 

On 

Modbus Interface DIII 

On 
On 

Unit 

  

On 
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Attention: In case the BMS does not copy (see 5.) and sends an On command to the unit. 
Then the requested On command will not be executed. 
 
Status 

 

The BMS sends an On command to the unit. 

 
 
 
 

  

User 
interface 

Off 
- 

BMS 

- 

On 

Modbus Interface DIII 

Off 
Off 

Unit 

  

On 

User 
interface 

Off 
On 

BMS 

- 

On 

Modbus Interface DIII 

On 
Off 

Unit 

  

On 
On 

The value of the holding register is not changed.  So the Modbus Interface 
DIII does not send the command to the units. 

On 
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2.3.3 Other DIII devices exist in the same system 
 
(See 1.5 Overview of compatibilty with other DIII centralised control equipment) 
 
No priority ranking is implemented. Meaning in case another DIII device is detected, the lock button & force 
OFF functions are not available. 
 
 
 
 
 
  

Detect other DIII 
device 

Return: No 

Check Other DIII device exists (30001) 

BMS Modbus Interface DIII Other DIII device (e.g. 
iTM) 

Power on 

Power on 

Other DIII device exists (30001 
bit 1): No 

(Forced OFF functions & lock 
functions available) 

Return: Yes 

Check Other DIII device exists (30001) 

Other DIII device exists (30001 
bit 1): Yes 

(Forced OFF functions & lock 
functions not available) 

 
 

BMS can use 
Forced OFF 
functions and lock 
functions 

BMS cannot use 
Forced OFF 
functions and lock 
functions 
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3. Modbus registers 
 
Input registers 

30001 till 30009 General Modbus Interface DIII status (incl. Detected DIII units & communication 
status of DIII units) 

31001 and higher Individual DIII units information 

 
Holding registers 

41001 Modbus Interface DIII central “forced off” 

42001 and higher Individual DIII units instructions 

 
Calculation method for input & holding registers of each connected DIII group address: 
 
DIII group address has an “upper address” and a “lower address”.  
Example for 1-00: “1” is the upper address, “00” is the lower address. 
 
Register of a DIII group address: Base register+((upper address-1)*16+lower address)*step 
 
E.g. capability input register for 4-15: 31001+((“4”-1)*16+”15” )*3 = 31190 
 

3.1. Input registers  
 
 

Input 
register 

Bit Description Meaning  

30001 15..2 -   

1 Other DIII 
device exists 

0: No 
1: Yes 

Note: When another DIII device is connected 
or disconnected to the DIII, it can take up till 
10 minutes to update the status of the input 
register. 
(Remark: Initially delivered from factory the 
value is 1) 

0 Modbus 
Interface DIII 
status  

0: Busy 
1: ready 

Typical at power on of the option, the DIII 
communication is started with the connected 
DIII units. At the end of the communication 
start up, all the input registers and holding 
resisters have the correct initial values. 

30002 15..0 DIII unit 
connected 
status 

0: not 
connected 
1: connected 

DIII address 1-00 (bit 0) till 1-15 (bit 15) 

30003 15..0 DIII address 2-00 (bit 0) till 2-15 (bit 15) 

30004 15..0 DIII address 3-00 (bit 0) till 3-15 (bit 15) 

30005 15..0 DIII address 4-00 (bit 0) till 4-15 (bit 15) 

30006 15..0 DIII unit 
communication 
status 

0: Normal 
1: Com-
munication 
error 

DIII address 1-00 (bit 0) till 1-15 (bit 15) 
Typically when a DIII device is connected 
once, and then disconnected: it can take up 
till 10 minutes to discover the communication 
error. 

30007 15..0 DIII address 2-00 (bit 0) till 2-15 (bit 15) 

30008 15..0 DIII address 3-00 (bit 0) till 3-15 (bit 15) 

30009 15..0 DIII address 4-00 (bit 0) till 4-15 (bit 15) 
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Indoor unit 
capability 

Fan speed capability(*not split) 
Fan speed levels capability(*not split) 
Fan direction capability(*not split) 
Fan direction levels capability(*not 
split) 
Dry mode capability 
Auto mode capability 
Heating mode capability 
Cooling mode capability 
Fan mode capability (*not split) 

O O - O* O O O O O 

31001 (1-00) 
31004 (1-01) 
.. (step of 3) 
31190 (4-15) 
 
 

Bit Description Meaning  

15 Fan speed 
capability 

0:Not exist 
1: Exist 

 

14 Fan speed 
steps 
capability 

0 till 7 
 

This value has only meaning if “Fan speed capability” 
exists 
0: -, 1:Fix, 2: 2step, 3: 3 step, 4: 4 step, 5: 5 step, 6: -, 7: - 

13 

12 

11 Fan 
direction 
capability 

0:Not exist 
1: Exist 

 

10 Fan 
direction   
steps 
capability 

0 till 7 
 

This value has only meaning if “Fan direction capability” 
exists 
0: -, 1:Fix, 2: 2step, 3: 3 step, 4: 4 step, 5: 5 step, 6: -, 7: - 

9 

8 

7 -   

6 -   

5 -   

4 Dry mode 
capability 

0:Not exist 
1: Exist 

 

3 Auto mode 
capability 

0:Not exist 
1: Exist 

 

2 Heating 
mode 
capability 

0:Not exist 
1: Exist 

 

1 Cooling 
mode 
capability 

0:Not exist 
1: Exist 

 

0 Fan mode 
capability 

0:Not exist 
1: Exist 
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Room temperature 
set point range 

Set point of indoor units range 
*for split: fixed values refer to 
KRP928BB2S documentation 

O O - O* O O O O - 

31002 (1-00) 
31005 (1-01) 
.. (step of 3) 
31191 (4-15) 

Bit Description Meaning  

15..8 Unit cooling 
set point 
lower limit 

- 128 .. 127°C 8 bit signed integer 
(bit 15= sign) 
 

7..0 Unit cooling 
set point 
upper limit 

- 128 .. 127°C 8 bit signed integer 
(bit 7= sign) 
 

31003 (1-00) 
31006 (1-01) 
.. (step of 3) 
31192 (4-15) 

15..8 Unit 
heating set 
point lower 
limit 

- 128 .. 127°C 8 bit signed integer 
(bit 15= sign) 
 

7..0 Unit 
heating set 
point upper 
limit 

- 128 .. 127°C 8 bit signed integer 
(bit 7= sign) 
 

(Note: Unit set point range is depending on unit e.g. 16 till 32°C.  
In some user interfaces, it is possible to change the set point range towards the user e.g. 20 till 30°C.  
But these values are independent from the unit set point range. Meaning unit set point range values are not 
modified. E.g. 16 till 32°C) 
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Indoor unit 
capability 

Leaving water set point exist  
Low noise capability 
Space heating capability  
Reheat capability 

- - - - O - - O O 

31401 (1-00) 
31405 (1-01) 
.. (step of 4) 
31653 (4-15) 

Bit Description Meaning  

15..6 -   

5 Reheat 
capability 

0: Not exist 
1: exist 

 

4 Space 
heating 
capability 

0: Not exist 
1: exist 

 

3 -   

2 Low noise 
capability 

0: Not exist 
1: exist 

 

1 Leaving 
water set 
point exist 

0: Not exist 
1: exist 

 

0 -   
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Leaving water set 
point range 

Leaving water set point range cooling 
and heating 

- - - - O - - O O 

31402 (1-00) 
31406 (1-01) 
.. (step of 4) 
31654 (4-15) 

Bit Description Meaning  

15..8 Unit cooling 
water set 
point upper 
limit 

- 128 .. 127°C 
(unity 1°C) 

8 bit signed integer 
(bit 15= sign) 
 

7..0 Unit cooling 
water set 
point lower 
limit 

- 128 .. 127°C 
(unity 1°C) 

8 bit signed integer 
(bit 7= sign) 
 

31403 (1-00) 
31407 (1-01) 
.. (step of 4) 
31655 (4-15) 

15..8 Unit 
heating 
water set 
point upper 
limit 

- 128 .. 127°C 
(unity 1°C) 

8 bit signed integer 
(bit 15= sign) 
 

7..0 Unit 
heating 
water set 
point lower 
limit 

- 128 .. 127°C 
(unity 1°C) 

8 bit signed integer 
(bit 7= sign) 
 

(Note: Unit set point range is depending on unit e.g. 5 till 20°C.  
In some user interfaces, it is possible to change the set point range towards the user e.g. 10 till 15°C.  
But these values are independent from the unit set point range. Meaning unit set point range values are not 
modified. E.g. 5 till 20°C) 
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On/Off On/Off status of indoor units 
* For VRV hydrobox LT & HT & 
Heating: 
On/off “space cooling/heating” 
status and control 

O O O O O* O O O* O 

“Forced off” “Forced off” status of indoor unit 
(for each unit separate) (by T1-T2 or 
by central “Forced off” from the 
Modbus Interface DIII) (HRV: no 
“Forced off” status) 

O O - O O O O O O 

Indoor status Thermostat status 
Indoor fan status (if present) 
Heater status (if present) 

O O - O O O O O O 

Fan speed (Air flow 
rate) 

LL, L, M, H, HH (depending on indoor 
unit capability) 
* Air curtain:  
CYV models: not available  
CYQ models: available 
* HRV (ventilation rate): 
VAM models: available 
VKM models: not available 

O O O* - - O* - - - 

Fan direction Swing, Flap direction (depending on 
indoor unit capability) 

O O - - - - - - - 

32001 (1-00) 
32007 (1-01) 
.. .. (step of 6) 
32379 (4-15) 

Bit Description Meaning  

15 -   

14 Fan speed 0 till 7 
 

This value is depending on “fan speed steps capability” 
value 

Value 0 1 2 3 4 5 6 7 

Fix - - - - - H - - 

2step Auto L - - - H - - 

3step Auto L - M - H - - 

5step Auto LL L M H HH - - 

HRV (ventilation rate): 
(note for HRV: fan speed steps capability is fixed to 0) 
For VAM units: value 3:L, 7:H 

13 

12 

11 -   

10 Fan 
direction 

0 till 7 
 

This value has only meaning if “Fan direction capability” 
exists 
0: P0, 1: P1, 2:P2, 3: P3, 4: P4, 5: -, 6: Stop, 7: swing 
P0 = horizontal direction 
P4 = vertical direction 

9 

8 

7 Thermo 
status 

0: Off 
1: On 

 

6 Heater 
status 

0:Off 
1: On 

 

5 Fan status 0: Off 
1: On 

 

4 -   
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3 Normal 
operation 

0: Off 
1: On (normal) 
0: On (error) 

 

2 Forced off 
status 

0: none 
1: Forced off 

or Indoor status of “Forced off” of digital input T1-T2 
or by central “Forced off” by Modbus Interface DIII 

1 -   

0 On/off 
status 

0: Off 
1: On 
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Cooling/ Heating 
Operation setting 
mode 

Depending on indoor unit capability 
(fan only/Cool/heat/auto/dry) 
* for split: no fan only mode 
* for VRV hydrobox LT&HT & heating 
& applied:  
Only Heating&Cooling 
* for HRV: Only ventilation 

O O O* O* O* O O O* O* 

Filter sign Filter sign of indoor units  
* Air curtain:  
CYV models: not available 
CYQ models: available 

O O O - - O* - O - 

Indoor status Defrost/hot start status 
Operation status 

O O - O O O O O O 

Cool/heat master O O - - O O O O O 

32002 (1-00) 
32008 (1-01) 
.. .. (step of 6) 
32380 (4-15) 

Bit Description Meaning  

15 Cool/heat 
master 

0 till 2 0: not decided  
1: Slave 
2: Master (means possible to change cool/heat 
operation mode via this indoor unit) 

14 

13 Defrost/ hot 
start status 

0: Off 
1: On 

 

12 -   

11 Operation 
status 

0 till 2 0: Fan, 1: Heating, 2: Cooling 
Actual running status. 10 

9 

8 

7 Filter sign 
status 

0: Off 
1 till 15: On 

 

6 

5 

4 

3 Operation 
mode setting 

0 till 7 0: Fan, 1: Heating, 2: Cooling, 3: Auto 
4:Ventilation,5:-,6:-,7: Dry 2 

1 

0 
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Room temperature 
set point 

Set point of indoor units  O O - O O O O O - 

32003 (1-00) 
32009 (1-01) 
..(step of 6) 
32381 (4-15) 

Bit Description Meaning  

15..0 Set point - 127,9 .. 
127,9°C 
(unity: 0,1°C) 

16 bit signed integer equals the value multiplied by 10 
(bit 15= sign) 
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Room temperature Suction temperature of indoor units 
(or user interface sensor 
temperature) 
* Split: KRP928BB2S is required 

O O - O* O - O O - 

32005 (1-00) 
32011 (1-01) 
.. (step of 6) 
32383 (4-15) 

Bit Description Meaning  

15..0 Room 
temperature 

- 511,9 .. 
511,9°C 
(unity: 0,1°C) 

16 bit signed integer equals the value multiplied by 10 
(bit 15= sign) 

 
Additional notes concerning the room temperature Or Suction temperature. 
By default the Suction temperature value is applicable. 
 
If the room temperature of the user interface (e.g. BRC1E52A/B7 or BRC2/3E52C7) is required, following 
settings should be confirmed on the user interface: 
  

Mode No. – 
First Code 
No. 
 
(   ) = group 
setting 

Description of setting Required values: 

User interface settings (e.g. BRC1E52A/B7 or BRC2/3E52C7)  

1c – 1 Thermostat sensor used for the  
"Auto" operation mode and the  
Setback function (room temperature on detailed 
display). 

Value 02: 
Remote controller  
thermistor 

Unit settings 

10 (20) – 2 
 

Thermostat sensor in the remote  
controller 

Value 03: 
Use exclusively 

10 (20) – 5 Sensor value information to DIII devices Value 02: 
Sensor value as 
set by 10-2-0X or 10-6-0X. 

10 (20) – 6 Thermostat sensor in group 
control 

Value 02: 
Use both the unit sensor (or 
remote sensor if installed) AND 
the remote controller sensor. 

 
For more information, refer to the installation manual of applicable indoor unit. 
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Leaving water set 
point 

Leaving water set point cooling and 
heating  
* Applied: “cooling negative leaving 
water set point” feature: depending 
if function is integrated in unit. 

- - - - O - - O O* 

32801 (1-00) 
32805 (1-01) 
.. (step of 4) 
33053 (4-15) 

Bit Description Meaning  

15..0 Heating 
water Set 
point 

- 127,9 .. 
127,9°C 
(unity: 0,1°C) 

16 bit signed integer equals the value multiplied by 10 
(bit 15= sign) 

32802 (1-00) 
32806 (1-01) 
.. (step of 4) 
33054 (4-15) 

15..0 Cooling 
water Set 
point 

- 127,9 .. 
127,9°C 
(unity: 0,1°C) 

16 bit signed integer equals the value multiplied by 10 
(bit 15= sign) 
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Domestic hot 
water 

Reheat enable/ disable status 
Storage start requested 
Storage set point 

- - - - O - - O - 

Quiet mode (low 
noise) 

 - - - - O - - O O 

32803 (1-00) 
32807 (1-01) 
.. (step of 4) 
33055 (4-15) 

Bit Description Meaning  

15..8 Storage set 
point 

- 128 .. 127°C 
(unity 1°C) 

8 bit signed integer equals the value multiplied by 10 
(bit 15= sign) 
 

7..3 -   

2 Low noise 
On/Off 
status 

0: Off 
1: On 

 

1 Storage 
started 
request 

0: none 
1: started 
request 

 

0 Reheat 
On/Off 
status 

0: Off 
1: On 
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Ventilation 
operation mode 

*VAM models: available 
VKM models: not  available 

- - O* - - - - - - 

32804 (1-00) 
32808 (1-01) 
.. (step of 4) 
33056 (4-15) 

Bit Description Meaning  

15..8 -   

7 Ventilation 
operation 
mode 
setting 

1: Auto 
2: Energy 
reclaim 
ventilation 
3: Bypass 

 

6 

5..0 -   
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Error Error, Alarm & Warning status  
with code and sub-code 
code values in ASCII code 

O O O O O O O O O 

33601 (1-00) 
33603 (1-01) 
.. (step of 2) 
33727 (4-15) 

Bit Description Meaning  

15 Error/ 
alarm/ 
warning 
code 
character 
(higher) 

ASCII (dec) Example: 
0100 0011 0011 0111    
 
Error code character (higher) 
01000011 (bin) =  67(dec) = ASCII “C” 
 
Error code character (lower) 
00110111 (bin) =  55 (dec) = ASCII “7” 
 
Error code: “C7” 
 
Note: In case no error exists, then following 
0011 0000 0011 0000 
0011 0000 (bin) =  48(dec) = ASCII “0” 
 
Error code character (lower) 
0011 0000 (bin) =  48 (dec) = ASCII “0” 
 
Error code: “00” (means no error) 

14 

13 

12 

11 

10 

9 

8 

7 Error/ 
Alarm/ 
warning 
code 
character 
(lower) 

ASCII (dec) 

6 

5 

4 

3 

2 

1 

0 

33602 (1-00) 
33604 (1-01) 
.. (step of 2) 
33728 (4-15) 

15 Error/ 
Alarm/ 
warning 
unit 
number 

0.. 15 Note: only if different units are connected to the same 
DIII group address 14 

13 

12 

11 -   

10 Warning 
status 

0: Normal 
1: Warning 

(note: in case of Warning, the unit will not be stopped) 

9 Alarm 
status 

0: Normal 
1: Alarm 

(note: in case of Alarm, the unit will not be stopped) 

8 Error status 0: Normal 
1: Error 

(note: in case of Error, the unit will is stopped) 

7 -   

6 

5 Error/ 
Alarm/ 
Warning 
sub code 

0.. 63 Note: only valid for Errors were a sub-code exists 

4 

3 

2 

1 

0 
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“Forced off” Central “Forced off” for all 
connected DIII units. 
Actual behaviour depending on user 
interface.  
Example: 
BRC1E52A/B7 & BRC2/3C52C7 

centralized control icon  is shown 
and all connected DIII units are 
forced off. 
 
(Note: 
Central “forced off”: Only available 
when no other DIII device is 
detected.  
See Input register “Other DIII device 
exists“ 30001 bit 1) 

O O O O O O O O O 

41001 Bit Description Meaning  

15..1 -   

0 Centralised 
forced off 

0: none 
1: Forced 
off 

Initial value is 0. 

 
Additional information concerning the forced off function. 
 
Situation 1: A DIII unit that lost communication to Modbus Interface DIII (due to wire communication problem 
or power outage of Modbus InterfaceDIII): 
 

Consequence:  After some minutes, the forced off will automatically be de-acivated by the DIII unit. 
 
Modbus Interface DIII required actions to return to the previous state: 
In case Modbus Interface DIII also had a power outage:  

After the power is restored and the DIII unit is discovered then re-activation (holding register 
set) of forced off function is required. 

In case Modbus Interface DIII lost communication with DIII unit:  
After re-discovery, de-activation (holding register reset) and re-activation (holding register 
set) of forced off function is required. 

 
Situation 2: A power outage of a DIII unit only 

Consequence: After the power is restored, the forced off is automatically activated again. 
 
Situation 3: A power outage of a DIII unit and Modbus Interface DIII at the same time: 

Consequence:  After the power is restored, the forced off is de-acivated. 
 

Modbus Interface DIII required actions to return to the previous state: 
After the power is restored and the DIII unit is discovered, re-activation (holding register set) 
of forced off function is required. 
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On/Off On/Off of indoor units 
* For VRV hydrobox LT & HT & 
Heating: 
On/off “space cooling/heating” 

O O O O O* O O O* O 

Fan speed (Air 
flow rate) 

LL, L, M, H, HH (depending on indoor 
unit capability) 
* Air curtain:  
CYV models: not available CYQ models: 
available 
HRV (ventilation rate): 
VAM models: available 
VKM models: not available 

O O O* - - O* - - - 

Fan direction Swing, Flap direction (depending on 
indoor unit capability) 

O O - - - - - - - 

42001 (1-00) 
42004 (1-01) 
.. (step of 3) 
42190 (4-15) 

Bit Description Meaning  

15 -   

14 Fan speed 0 till 7 
 

This value is depending on “fan speed steps capability” 
value 

Value 0 1 2 3 4 5 6 7 

Fix - - - - - H - - 

2step Auto L - - - H - - 

3step Auto L - M - H - - 

5step Auto LL L M H HH - - 

(note: Fan control flag bit 7-6-5-4 must be set to value 6) 
Note: The BMS needs to copy input register value: 
32001 (1-00)… bit 14-13-12 to this holding register. 
(note: in case no fan capability this register should be 
set to 0) 
 
HRV (ventilation rate) : For VAM units:  
Values 0/1/2:L & 3/4/5/6/7:H 
(note for HRV: fan speed steps capability is fixed to 0) 
(note for HRV: Fan control flag bits 7-6-5-4 are not 
applicable)  
(note for HRV: Related input register with actual value: 
32001 (1-00)… bit 14-13-12 
Attention during the BMS copy: value 3 “L” of input 
register should be translated to value 2 “L” in holding 
register by the BMS to avoid a change to “H” ventilation 
rate. 
Value 7 “H” of input register can be copied to equal 
value7 “H” in holding register.) 

13 

12 

11 -   

10 Fan direction 0 till 7 
 

This value has only meaning if “Fan direction capability” 
exist 
0: P0, 1: P1, 2:P2, 3: P3, 4: P4, 5: -, 6: Stop, 7: swing 
P0 = horizontal direction 
P4 = vertical direction 
(note: Fan control flag must be set to value 6) 

9 

8 



4P642495-1A– 2022.02  Page 34 of 52 
 

Note: The BMS needs to copy input register value: 
32001 (1-00)… bit 10-9-8) to this holding register 

7 Fan control flag 0: no fan 
control 
6: fan 
control 

In case fan control: This register has to be set to value 6 
In case no fan control: this register has to be set to value 
0 
For HRV: “fan control flag” has no impact on ventilation 
rate control bit 14-13-12 

6 

5 

4 

3 -   

2 -   

1 -   

0 On/off 0: Off 
1: On 

Note: The BMS needs to copy input register value: value: 
32001 (1-00)… bit 0) to this holding register 
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Cooling/ Heating 
Operation mode 

Depending on indoor unit capability 
(fan only/Cool/heat/auto/dry) 
* for split: no fan only mode 
* for VRV hydrobox LT&HT & heating 
& applied: 
Only Heating&Cooling 

O O - O* O* O O O* O* 

Filter sign Filter sign reset of indoor units  
* Air curtain:  
CYV models: not available 
CYQ models: available 

O O O - - O* - O - 

42002 (1-00) 
42005 (1-01) 
.. (step of 3) 
42191 (4-15) 

Bit Description Meaning  

15..8 -   

7 Filter sign reset 0: none 
15: reset 

Attention: After reset, set to value 0 again. Otherwise 
filter sign will never appear again. 6 

5 

4 

3 Operation 
mode setting 

0 till 7 0: Fan, 1: Heating, 2: Cooling, 3: Auto 
4:Ventilation,5:-,6:Setpoint/Dependent ,7: Dry 
(note 6: Set point/Dependent is used when the indoor 
unit is not cool/heat master) 
Note: “illegal data” is returned in case not possible to 
set the value on the unit.  (see chapter 2.2.1 Function 
format) 
(e.g. Set holding register to “1:heating” value to a unit 
that cannot be put to heating) 
(possible to check register 31001 for fan / cooling / 
heating / auto / dry mode  capability) 
Note: The BMS needs to copy input register value: 
32002 (1-00)… bit 3-2-1-0 to this holding register 

2 

1 

0 
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Holding register 
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Room temperature 
set point 

Set point of indoor units  O O - O O O O O - 

42003 (1-00) 
42006 (1-01) 
.. (step of 3) 
42192 (4-15) 

Bit Description Meaning  

15..0 Set point - 127,9 .. 
127,9°C 
(unity: 0,1°C) 

16 bit signed integer equals the value multiplied by 10 
(bit 15= sign) 
 
Remark:  
1. In case the requested value is out of the  unit set 
point range and/or the user interface set point range, 
the set point is set to the minimum limit value or higher 
limit value.  
2. For the result please check for the value in the input 
register. 
 
Note: The BMS needs to copy input register value: 
32003 (1-00)… bit 15..0) to this holding register 
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Leaving water set 
point 

Leaving water set point cooling and 
heating  
* Applied: for cooling negative 

leaving water set point: depending if 

function is integrated in unit 

software. 

- - - - O - - O O* 

42401 (1-00) 
42405 (1-01) 
.. (step of 4) 
42653 (4-15) 

Bit Description Meaning  

15..0 Heating 
water Set 
point 

- 127,9 .. 
127,9°C 
(unity: 0,1°C) 

16 bit signed integer equals the value multiplied by 10 
(bit 15= sign) 
 
Remark:  
1. In case the requested value is out of the  unit set 
point range and/or the user interface set point range, 
the set point is set to the minimum limit value or higher 
limit value.  
2. For the result please check for the value in the input 
register. 
Note: The BMS needs to copy input register value: 
32801 (1-00)… bit 15..0 to this holding register. 

42402 (1-00) 
42406 (1-01) 
.. (step of 4) 
42654 (4-15) 

15..0 Cooling 
water Set 
point 

- 127,9 .. 
127,9°C 
(unity: 0,1°C) 

16 bit signed integer equals the value multiplied by 10 
(bit 15= sign) 
 
Remark:  
1. In case the requested value is out of the unit set point 
range and/or the user interface set point range, the set 
point is set to the minimum limit value or higher limit 
value.  
2. For the result please check for the value in the input 
register. 
Note: The BMS needs to copy input register value: 
32802 (1-00)… bit 15..0 to this holding register 
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Holding register 
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Domestic hot 
water 

Reheat enable/ disable status 
Storage set point 

- - - - O - - O - 

Quiet mode (low 
noise) 

 - - - - O - - O O 

42403 (1-00) 
42407 (1-01) 
.. (step of 4) 
42655 (4-15) 

Bit Description Meaning  

15 Storage set 
point 

- 128 .. 
127°C 
(unity 1°C) 

8 bit signed integer equals the value multiplied by 10 
(bit 15= sign) 
 
Remark:  
1. In case the requested value is out of the unit set point 
range and/or the user interface set point range, the set 
point is set to the minimum limit value or higher limit 
value.  
2. For the result please check for the value in the input 
register. 
Note: The BMS needs to copy input register value: 
32803 (1-00)… bit 15..8 to this holding register. 

14 

13 

12 

11 

10 

9 

8 

7..4 -   

3 -   

2 Quiet mode 
(Low noise) 
On/Off 

0: Off 
1: On 

Note: The BMS needs to copy input register value: 
32803 (1-00)… bit 2 to this holding register. 

1 -   

0 Reheat On/off 0: Off 
1: On 

Note: The BMS needs to copy input register value: 
32803 (1-00)… bit 0 to this holding register. 
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Ventilation 
operation mode 

*VAM models: available 
VKM models: not  available 

- - O* - - - - - - 

42404 (1-00) 
42408 (1-01) 
.. (step of 4) 
42656 (4-15) 

Bit Description Meaning  

15.. 
8 

-   

7 Ventilation 
operation 
mode setting 

(0:No 
meaning) 
1: Auto 
2: Energy 
reclaim 
ventilation 
3: Bypass 

 
 
(remark: not possible to detect if unit has capability or 
not) 
 
Note: The BMS needs to copy input register value: 
32804 (1-00)… bit 7-6 to this holding register. 

6 

5..0    
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Holding register 
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user interface 
lock 
(button)  
 
(Note: 
Only available 
when no other 
DIII device is 
detected  
See Input register 
“Other DIII device 
exists“ 30001 bit 
1) 

- On/off lock (no lock, On lock, Off 
lock) 
- Operation mode change lock  
- Up-down temperature lock 
- Fan speed lock (if fan present) 
- Fan direction lock (if fan present) 
Actual behaviour depending on user 
interface.  
Example: 
BRC1E52A/B7 & BRC2/3C52C7 

centralized control icon   is shown 
and locked function cannot be done. 
 
* Split (with KRP928BB2S) 
- On/Off lock (no lock, on/off lock)  
- Operation mode change & set point 
locked together. 
Function:  
Locked functions are ignored. 
 
* HRV:  
- On/off lock (no lock, On lock, Off 
lock) 

O O O* O* O O O O O 

42801 (1-00) 
42802 (1-01) 
.. (step of 1) 
42864 (4-15) 

Bit Description Meaning  

15..7 -   

6 - Fixed to 0  

5 User interface 
button fan 
speed 
(up/down) 
Lock 

0: Enabled 
1: Disable 

Note: for * Split (with KRP928BB2S),No meaning 

4 User interface 
button fan 
direction 
(up/down) 
Lock 

0: Enabled 
1: Disable 

Note: for * Split (with KRP928BB2S),No meaning 

3 User interface 
button 
operation 
mode 
Lock 

0: Enabled 
1: Disable 

Note: for * Split (with KRP928BB2S), Operation mode 
change button lock & set point (up/down) button lock 

2 User interface 
button set 
point 
(up/down) 
Lock 

0: Enabled 
1: Disable 

Note: for * Split (with KRP928BB2S), No meaning 

1 User interface 
button Off 
Lock 

0: Enabled 
1: Disable 

Note: for * Split (with KRP928BB2S), No meaning 
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0 User interface 
button On 
Lock 

0: Enabled 
1: Disable 

Note: for * Split (with KRP928BB2S), User interface 
On/off lock 

(Note: There is no related input register with actual value) 
 
Additional information concerning the lock function. 
 
Situation 1: A DIII unit that lost communication to Modbus Interface DIII (due to wire communication problem 
or power outage of Modbus InterfaceDIII): 
 

Consequence:  After some minutes, the lock will automatically be de-acivated by the DIII unit. 
 

Modbus Interface DIII required actions to return to the previous state: 
 
In case Modbus Interface DIII also had a power outage:  

After the power is restored and the DIII unit is discovered then re-activation (holding register 
set) of lock functions is required. 

In case Modbus Interface DIII lost communication with DIII unit:  
After re-discovery, de-activation (holding register reset) and re-activation (holding register 
set) of lock functions is required. 

 
 
Situation 2: A power outage of a DIII unit only  

 
Consequence: After the power is restored, the lock is automatically activated again. 

 
 Modbus Interface DIII required actions: none 
 
Situation 3: A power outage of a DIII unit and Modbus Interface DIII at the same time: 
 

Consequence:  After the power is restored, the lock is de-acivated. 
 

Modbus Interface DIII required actions to return to the previous state: 
After the power is restored and the DIII unit is discovered, re-activation (holding register set) 
of lock functions is required. 
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4. Software of Modbus Interface DIII 
 

4.1 Software releases 
 
Always verify whether you are using the latest software release. A list of the currently available software 
releases can be found on the Business Portal. For more information about the software itself, see below. 

4.2 Software update with Updater 
 
The Modbus Interface DIII software can be updated with the Daikin Updater PC software.  
- At least updater v1.4.x is required. For availability, please contact your local service contact for the latest 
version. 
- Products shipped at launch start-up will require a software update to be able to function. 
 
Two possible connections to connect the PC to the Modbus Interface DIII: 
 
Method 1) With the PC USB cable EKPCCAB* connected to the X2A of the main board.  
Method 2) With a USB/RS485 converter (Daikin spare - part reference 999417P) connected one on one to the 
RS485 Modbus port (& dipswitch DS1 off/off/off/off setting & DS2 is not off/off/off/off e.g. DS2 is 
off/off/off/on) 
 

4.2.1 Updater  
 
The updater PC program can be executed without admin rights. 
(Remark: only during the one time USB driver installation, admin rights are required) 

4.2.1.1 Updater Minimum PC requirements: 
 
Updater (v1.4.x and higher): 
- Windows XP (SP3), Windows Vista (SP2) or Windows 7 or Windows 8/8.1 
- Microsoft .NET FrameWork 4.0 (aka .NET 4.0) 
- Microsoft Office 2010 OR “Microsoft Access Database Engine 2010 Redistributable” 
(http://www.microsoft.com/en-us/download/details.aspx?id=13255) 
 
- Pentium III 400 MHz or faster 
- Free USB 2.0 port, capable of supplying 50 mA current 
 

4.2.1.1 EKPCCAB* driver 
 
In case PC USB cable EKPCCAB* is used for the first time on a PC, it is required to install the following USB 
driver with admin rights. 
 
The needed USB driver can be downloaded from “http://www.ftdichip.com/Drivers/VCP.htm”  
E.g. download “setup executable” “2.10.00 WHQL Certified.exe” and run with admin rights. 
 
Follow the instructions to install. 
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4.2.2 Method 1) Update with the PC USB cable EKPCCAB*. 
 

 
 
 
 
Instructions: 
1. Make sure that the Modbus Interface DIII is powered off. 
2. Connect the EKPCCAB* cable to X2A on the mainboard (see figure). 
3. Power on the Modbus Interface DIII. 
4. Start the updater on the PC. 

 
5. Proceed to the Setting menu and make sure the correct USB serial COM port is selected (e.g. COM4). 

  
6. Proceed to the "Update Procedure Selection" window. The ID of the existing software is automatically 
detected. 
  

PC USB cable EKPCCAB* 
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7. Fill in the model name "EKMBDXB7V1" in the filter box and select the available software. 

 
 
8. Follow the on-screen instructions. 
 
Example of a successful update: 
 

 
 

 
 
9. At the end switch off power and disconnect all programming cables. 
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4.2.3 Method 2) Update with a USB/RS485 converter. 
 

 
 
 
 
Instructions:  
 
1. Make sure that the Modbus Interface DIII is powered off. 
2. Disconnect all existing Modbus RS485 A+/B- connections and connect the USB/RS485 converter to X3M (see 
figure). 
3. Set dipswitch DS1 & DS2 as indicated in the figure. 
4. Power on the Modbus Interface DIII. 
5. Start the updater on the PC. 

 
6. Proceed to the Setting menu and make sure the correct USB serial COM port is selected (e.g. COM4). 

  
 
7. Proceed to the "Update Procedure Selection" window. The ID of the existing software is automatically 
detected. 
  

“Rx+/Tx+” =>“A+” 
“Rx-/Tx-“ => “B-“ 

DS1 off/off/off/off setting 
DS2 is not off/off/off/off (e.g. DS2 is off/off/off/on) 

USB/RS485 converter (Daikin spare - part reference 999417P) 
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8. Fill in the model name "EKMBDXB7V1" in the filter box and select the latest available software. 

 
9. Follow the on-screen instructions. 
 
Example of a successful update: 
 

 
 

 
 
10. At the end, switch off power and disconnect all programming cables. 
11. Re-set the dipswitches to the required values. 
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5. Modbus Interface DIII test operation 
 

5.1 Introduction 
 
To test the operation of the Modbus Interface DIII setup connected to the units, a Modbus master program on 
a PC can be used. 
 
An example is “Modbus Poll” PC program. 
Internet download location: http://www.modbustools.com/modbus_poll.asp (shareware with a time limited 
trial period.) 

5.2 Outline of system 
 

 
 
 
 
 
 
 
 
 
  

“Rx+/Tx+” =>“A+” 
“Rx-/Tx-“ => “B-“ 

DS1 off/off/off/off setting = 9600bps Even 1 stop bit 
DS2 off/off/off/on = Modbus address 1 

USB/RS485 converter 
(Daikin spare - part 
reference 999417P) 
 

“Modbus poll” 
PC program 

F1/F2 connected to 
the units 

http://www.modbustools.com/modbus_poll.asp
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5.3 Test Operation Procedure 
 
Following test examples are explained by using “Modbus poll” version 6.0.2 

5.3.1 Prepare register groups 
 
1. Start-up “Modbus poll” 

 
 
2. Setup the input registers or holding register groups by selecting following in the dropdown menu: 
“File” > “New      Crtl+N” 
& “Setup” > “Read/Write Definition…    F8” 
Note: Each registers group can be separately saved by “File” > “Save as … “ (*.mbp) 

Example how to define the input registers 30001 till 30008 
Note: In “Modbus poll” the register address is defined as follows: 30011 -> 10 

 

 
For each register the “Alias” description can be set 
For each register the “Format” should be set by right 
clicking: “Format > binary” 
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3. Prepare register groups as following examples: 
 

Example Read input registers 30001 till 30008 

 

 

Example Read input registers 31001 till 31003 

 

 

Example Read input registers 32001 till 32003 

 

 
(for set point select “Format > Signed) 
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Example Read holding registers 42001 till 42003 

 

 
(for set point select “Format > Signed) 
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5.3.2 Start reading registers groups 
 
Select “Connection > Connect F3” 
(Example) 

 
After making the correct selections, click OK to start reading the register groups. 
 

Example Read input registers 30001 till 30008 Example Read input registers 31001 till 31003 

 
 

Example Read input registers 32001 till 32003 Example Read holding registers 42001 till 42003 
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5.3.3 Set a holding register 
 
To change a holding register, proceed as follows: 

 

Double click on value to modify bits as follows: 
(e.g. change to On) 

 

 

Double click on value to modify bits as follows: 
(e.g. change set point to 20.0 °C) 
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6. Troubleshooting 
 

Problem Possible causes Required actions 

No Modbus 
communication 

No correct Modbus address setting was 
present at power on of the Modbus Interface 
DIII. 

During power off: 
Set DS2 according to the required 
Modbus address. 
See chapter “1.3.6 Dipswitch 
meaning”. 
The dipswitch on/off status is 
detected only at the time of power 
on of the PCB. 

No Modbus address setting is set (=DS2: 
Off/Off/Off/Off). 

Set DS2 according to the required 
Modbus address. 
See chapter “1.3.6 Dipswitch 
meaning”. 

Only firmware is present on the Modbus 
Interface DIII. HAP: is blinking at a fast rate of 
200ms meaning firmware is running. 

Upload the latest application 
software. 
See chapter “4.2 Software update 
with Updater”. 

Software update 
with updater (via 
RS485) fails 

DS2 is set to off/off/off/off. (meaning no 
communication on RS485). 

Change DS2 settings to e.g. 
off/off/off/on. 
Refer to chapter “4.2.3 Method 2) 
Update with a USB/RS485 
converter.”. 

A BMS set of a 
holding register is 
not reflected on the 
actual unit. 

Modbus Interface DIII sends the command to 
a unit when the value of a Holding Register is 
changed. Especially in case that indoor units 
are operated from the user interface. 

The BMS should always get the 
status of indoor units and copy the 
received status to the Holding 
Registers. 
Refer to chapter “2.3.2 Monitor and 
operate units from the BMS”. 
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7. Revision of the document  
 

2014.04 New 

2020.10 Adaptation for EKMBDXB7V1 

2022.02 Update operating frequency 
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